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RECTOR MESSAGE  

  
  
  

My Dear Students, Faculty Members and Staff, this is your Rector. On the instructions 

of the government, the university got closed for students on a weekend and, thus, I 

couldn’t address you. We indeed are passing through a very critical time due to 

coronavirus; not that we, as a nation, are confronted with a calamity of this magnitude 

for the first time; we have seen natural disasters like earthquakes and floods before as 

well and we came out triumphant as a resilient nation. This time again I am sure that with 

Allah’s help we will be able to combat and defeat this menace successfully. This is the 

time to act on our national slogan: “Faith, Unity and Discipline”. Now is the time I would 

like the students of NUML who are also responsible citizens of Pakistan to play their 

positive role in helping the nation to fight this problem. We as university cannot wait 

indefinitely for this virus to go away. To save our precious time and in keeping with the 

good international practices, we are starting online classes from coming Monday through 

the University’s Learning Management System (LMS). We are also mindful of those 

students who may not have access to this facility because of the remoteness of their 

respective areas, so we will make arrangements for them too. Such students are advised 

to contact their HoDs through WhatsApp, email or SMS. Remember, testing times come 

in the lives of nations, though this time we are not alone. Displaying our true national 

character and practically demonstrating the spirit of “Faith, Unity and Discipline”, we 

shall surmount this challenge too. I would also expect you to come forward and help out 

the needy and vulnerable around you. Pay heed to the instructions being issued by the 

government and other authentic agencies, and please do not become the tools to spread 

the rumors and panic.  

  

Lastly, it is also a moment of deep conviction and heart-searching for each one of us to re-

assess and re-affirm our relation with Allah SWT and His Creation—the humanity a large.  

  

May Allah SWT bless you all and keep you and your loved ones safe. Ameen!  

  

  

  

  

  

  

  

   

Prerequisites for Faculty Members  

1. Teachers have to create their Account on LMS using NUML Official Email Address.  
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2. Teachers will be able to see courses/subjects in LMS Dashboard if their departments have 

sent their course details in provided format to ICT department.  

3. Similarly, Students will be able to Login to their LMS account and will see their courses 

on dashboard if their Departments have their data to ICT department.  

4. Teachers will Enroll Registered Students in their respective courses/subjects.  

5. ICT took the responsibility and have already entered the NUML and configurational data 

in LMS in a way that teachers and students can start course activities without any hurdle.  
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NUML LMS  
  

Overview  

An easy to use Learning Management Systems (LMS) deployed two years back with its pilot 

project in Faculty of Engineering and Computer Sciences. The system gradually got mature and 

its orbit enhanced to other four faculties as well during last year.  

The recent Covid breakdown has enhanced its importance vis-à-vis its uses. The management very 

gracefully allowed the ICT team to put enhanced servers and now LMS is fully functional on latest 

server with ample backup arrangements.   

LMS provides an extensive platform for learning to its instructors & students. Students can view 

and access their course schedules, course descriptions, Online Lectures, assignments, grades, 

quizzes and many other services. They can also complete online assignments and participate in 

grouped discussions, moderated discussions and live sessions. The teachers after providing all 
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above resources can monitor student activities and can easily moderate online as well as offline 

class managements.  

The system will improve with the valuable user’s feedback which is the backbone of the learning 

system. The innovative learning technology will improve the quality of the academia. ICT always 

make an all-out effort to keep all the new plugins available in the NUML LMS system. NUML 

LMS ambient is being enhanced to NUML regional campuses by next month.  

Most importantly if you are entirely new in LMS environment then we suggest you to visit moodle 

demo pages and play around for some time. You will not damage anything but will be able to get 

a very good quick start. Here is the link: https://moodle.org/demo/  

  

  

  

   

…………………Good luck for a very happy journey through LMS  

REACH TO NUML LMS  

https://moodle.org/demo/
https://moodle.org/demo/
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This section will cover following;  

  

• LMS Help Desk  

• Access NUML LMS  

• Sign In / Sign Up  

• Forget Password  

  

  

LMS Help Desk  

ICT department took initiated to create an email address to receive and resolve the queries 

instantly. All concerns can report their problem through this medium and get solution as soon as 

possible.  

Queries should always be sent on following email:  

lms@numl.edu.pk  
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Access to NUML LMS  

  
  

1.  Go to NUML main website: https://numl.edu.pk/ . On top right side of website click 

on LMS.  

  
Figure 1 NUML website-> NUML LMS   

https://numl.edu.pk/
https://numl.edu.pk/
https://numl.edu.pk/
https://numl.edu.pk/
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Sign In/ Sign Up  

  

1. On clicking the NUML LMS Button this screen will be visible. Users will click on their 

respective faculty to login in the system   

  
Figure 2 NUML LMS Main Page  

  

2. On login page enter your username and password to login if you already have an LMS 

account or click on CREATE NEW ACCOUNT for new account. (Keep Prerequisites in 

mind as mention early in document)  
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           Figure 3 LMS Login Page  

3.In case of creating new account fill the necessary information. Enter your official Email address 

in Username and Email fields. Follow the instruction given on figure below.  

  

 
Figure 4 Create New Account Page  

4.On next screen you will receive this message to confirm your account through your email 

address.  



11  

 

Figure 5 Account Confirmation Message  

  
  
  

5. Go to your NUML Official Email inbox. A confirmation email sent by LMS, Click on 

confirmation link to confirm your account on NUML LMS.  

  

 

Figure 6 Confirmation Email to Teacher on his/her Email  

6.After login to your account you will see important information on your dashboard such as 

courses assigned to you, timeline, calendar etc.  



12  

  

 

Figure 7 Teacher Dashboard  

  

Forgotten Password  

  

1. From Login Screen, click on “Forgotten your username and password?” Link.  

  
Figure 8 Forget Password  

2. The account can be searched using email or username. Enter any of field and Press Search.  
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Figure 9 Enter Username or Email to reset  

  
  

3. You will receive a Link to change password in your NUML Official Email inbox.  

  

  

 

Figure 10 Password Reset Link  
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4. Enter the new Password and click on “SAVE CHANGES” button and the password will be 

changed.  

  

 
  

Figure 11 Password Change screen  

  

  

  

  

  

  

  

CREATING ASSIGNMENT   
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Assignment  

NUML LMS provides an easy way for a teacher to give the assignment to students, get submitted 

assignments and grade them. Teacher can set display time and deadline of assignment as well.  

Types of Assignments  

There are following several types of assignments available to use on LMS.  

a. Upload a single or multiple files  

b. Online Text  

  
• Upload a Single or Multiple Files A student can upload a single file, such as a word 

document, spreadsheet or anything digital while multiple files allows students to submit 

more than one file in the form of word, excel, PDF etc which can be zipped and then 

submitted.  

• B. Online Text: Under this type student submit their work online directly on LMS and 

teachers can view and grade their work online.  

  
Setting up/Creating an Assignment on LMS:  

  
  

1. Select the course from Left tab on your main home page, in which you want to create an 

assignment.  

 

Figure 01: My Home OR Site home>Course Name  
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2. Click the “Turn editing on” button at the top right of the course page.  

  

  

  

 
  
   

3. Click “Add an activity or resource” link. Activity: In activity the students are 

involved such as assignment, quizzes, workshops etc.  

  
Resource: The information shared by teacher on course portal are the resources such as lectures, 

manual etc.  

  

 
Figure 03: Course home page> Turn Editing On>Add an activity or resource  

4. Click on Assignment then click on “Add”. Assignment settings page will open.  

Figure 02: Course Page>Turn Editing On   
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Figure 04: Course home page>Add an Activity or Resource>Assignment>Add  

  
i. General Settings:  

• The general section allows you to give your assignment a name and description.  

• If the highlighted checkbox will be checked then description will be shown on course 

page for specified assignment.  
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Figure 05: General Settings>Assignment Name>Description  

  

ii. Availability: This availability section has few assignment settings that will allow a teacher 

to set dates for showing assignment to students on course page so that students can 

submit their assignment. Also disable submitting on cutoff date. The list of settings are;  

• Allow submissions from: This student to start accessing assignment onward from 

this date.  

• Due date: sets the date on which assignment will be due.  

• Cut-off date: After cut-off date the assignment submitting will be disable and 

students will not able to submit their assignments.  

• Remind me to grade by: A teacher can set a date to grade the assignments and  

LMS will show notification on teacher dashboard.  

• Always show description: The descriptions to be shown with assignment on course 

portal in case of selecting YES.  

• Require students click submit button: The option can be enabled that student to 

click submit button for final submission.  

• Require that students accept the submission statement: The submission term and 

condition to be accept by student before submitting his work if enabled.  

• Notify graders about submissions: A notification will be shown on teacher 

dashboard whenever any student will submit his assignment.  
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Figure 06: Assignment Availability Settings  

  
  
  

 iii. Submission Types Setting:  These settings configure the student end how they can submit 

their assignments.  

• Online text: This option will show the text editor and students can write or paste their 

work.  

• File submissions: The files can be uploaded such as MS Word, PDF, Excel etc  

• Maximum number of uploaded files: The students will be able to upload the number of 

uploaded value enter in this textbox.  

• Maximum submission size: The size of files that will be uploaded by each student is 

determine from this setting.  

• Accepted file types: The list of file extensions can be specify from this setting.  

  

  

  

 
  

Figure 07: Submission Types  

  

  

http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
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iv. Feedback Setting: This feedback setting allow teacher to opt the feedback mechanism.  

These mechanisms are;  

 Feedback Types:  

Feedback Comments: The teacher to provide comments for each submission by making 

this setting enable.  

Offline  Grading  Worksheet:  The teachers can download and upload the marks in 

worksheets by making this option enabled.  

Feedback Files: The teachers will be able to upload the files with feedback by 

making this option enabled.  Comment inline: The teacher can comment inline on 

each student’s submission.  

  

  

 

Figure 08: Feedback Setting  

  
  

v. Submission settings: These settings allow to determine the submission rules for student such 

as a. enforcing student to accept submission statement, b. attempt to reopen submitted assignments 

and c. maximum attempts.  

  

  

 

Figure09: Submission settings  

vi. Group submission settings: These settings allow students to submit in groups if marked YES.  

http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
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Figure10: Group submission settings   

http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
http://lms.numl.edu.pk/lms/course/modedit.php?add=assign&type&course=2019&section=0&return=0&sr=0
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GRAND ASSIGNMENT EXTENTION   
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The extension in assignment can be given to all students as well as selected students. In order to 

extend the due date of assignment, perform steps listed below.  

1. Select the course on your main home page, in which assignment is created.  

  

 
Figure 01: My Home>Course Name  

  

2. Course page will appear showing an assignment.  
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Figure 02: My Home>Course Name>Assignment  

  

3. On the Assignment page grading summary will appear. Click on “view/grade all 

submissions” button.  

  

 
Figure 03: Grading Summary  

  

4. The teacher can give the extension to selected students by selecting the check box in select 

column. The check box is highlighted in image below.  

  

  

  

 
Figure 04: Select the check box against student name>Add Grades  

  

5. Then choose the option of “With Selected” .  
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Figure 05: Select the check box against student name>Add Grades>With Selected  

  

6. From drop down menu select Grant Extension and Press GO Button 7. The 

new screen will show the extension due date section but these options will be 

disabled.  

8. Click on Enable in front of “Extension due date”.  

9. Change the dates and click Save Changes.  

 

Figure 06: Enable Extension Due Date>Click Enable checkbox>Save Changes  

  

  

  

LMS RESOURCES   
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LMS Resources  

Teachers will use resources for learning purpose, such as a file or link. In edit mode, a teacher can 

add resources via a drop down menu. Resources appear as a single link with an icon in front of it 

that represents the type of resource. There are several types of resources that can be uploaded on 

LMS:  

  
1. File - A picture, a pdf document, a spreadsheet, a sound file, a video file.  

2. Folder - For helping organize files and one folder may contain other folders.  

3. Label - Can be a few displayed words or an image used to separate resources and activities 

in a topic section, or can be a lengthy description or instructions  

4. Page - The student sees a single, scrollable screen that a teacher creates with the robust 

HTML editor  

5. URL - You can send the student to any place they can reach on their web browser, for 

example Wikipedia 6. Book - Multi-page resources with a book-like format.  

  
Books  

The book module enables a teacher to create a multi-page resource in a book alike format, with 

chapters and subchapters  

A book may be used  

  

• To display reading material for individual modules of study  

• As a staff departmental handbook  

• As a showcase portfolio of student work  

  
Adding Book  

  

Follow the below listed steps to add book on your course portal.  

  

1. Go to your course page by clicking your course in left panel.  

2. To add a resource, “turn editing on” mode by clicking the gear icon in the upper right of 

LMS page.  

http://docs.moodle.org/25/en/File_resource
http://docs.moodle.org/25/en/File_resource
http://docs.moodle.org/25/en/Folder
http://docs.moodle.org/25/en/Folder
http://docs.moodle.org/25/en/Label
http://docs.moodle.org/25/en/Label
http://docs.moodle.org/25/en/Page
http://docs.moodle.org/25/en/Page
http://docs.moodle.org/25/en/URL_resource
http://docs.moodle.org/25/en/URL_resource
http://docs.moodle.org/25/en/Book_module
http://docs.moodle.org/25/en/Book_module
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Figure 1: Dashboard> My Courses> Turn editing on.  

  

3. You can add activity by clicking on “Add an activity or resource” present on the right side 

of page.  

  

 
  

Figure 2: Course homepage> Add an activity or resource.  

  

4. By pressing Add an activity or resource new window will appear  

5. Scroll down and select Book then press "Add" button.  
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Figure 3: Course homepage> Add an activity or resource>Book>Add  

  

6. Enter General information in form to add book. The information that can be entered is;  

• Enter Title of Book  

• Then add description, it is optional so totally up to user if they want to add or not  

• Then adjust Setting if you want to  

• At the time of save book user have three options;  

a. user can save and return to course  

b. user can save the book and display the it at the spot  

c. user can cancel uploading it  
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Figure 4: Add an activity or resource>Book>Add  

  

7. Other Book Settings can be entered but not mandatory.  

• Appearance  

• Common module settings  

• Restrict access  

• Activity completion  

• Tags  

• Competencies  

i. Appearance  
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Teaches have fully control over the look of their book they can select chapter formatting and style 

of navigation for their book using drop-down. Chapter formatting allows you to select the chapter 

formatting. Formatting can be done in the form of numbers, bullets, indentations etc  

  

 
  

  

  

ii. Common module settings  

In case teacher want to display the book on certain date or hide the file at the moment of uploading 

this is the step to do it. Teachers can also hide the book from certain group if grouping is enabled 

in the course  
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8. Once the settings are done press “Save and return to the course” button to save and return  

to course or “Save and display” button to save and remain on the same page.  

  

9. After the book is created it will start appearing on the course homepage.  

  

 

Figure 5: Course homepage> Topic>Book  

  
  
  

Chapters  

  

1. On course Home page click on the Book icon to add chapters  

  

 

2. To add chapter in book, Add the following information ;  

• Write chapter name  

• Content  

• Then press save changes button  
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Figure 6: Course homepage> Topic>Book-1  

  

3. A chapter will be created and will be accessible inside the book  
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Figure 7: Course homepage> Topic>Book-1>Chapter-1  

  

Page  

The page module enables a teacher to create a web page resource using the text editor. A page can 

display text, images, sound, video, web links and embedded code, such as Google maps.  

A page may be used  

  

• To present the terms and conditions of a course or a summary of the course syllabus  

• To embed several videos or sound files together with some explanatory text Select 

Page option present in Resources. After that click on button Add.  

Page Creation  

  

1. To add a resource, turn editing on mode by clicking the gear icon in the upper right of LMS 

page.  

  

  

  

  

 
  

Figure 8: Dashboard> My Courses> Turn editing on.  

2. You can add activity by clicking on Add an activity or resource present on the right side 

of page.  
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Figure 9: Course homepage> Add an activity or resource.  

  

3. By pressing Add an activity or resource new window will appear  

4. Scroll down and select Page then press "Add" button.  

  

  

  

  

  

  

 
  

Figure 10: Course homepage> Add an activity or resource>Page>Add  

5. While page creation Teacher has to enter following information  

• write page name  

• Page description  
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• Then write page content  

  

 
  

Figure 11: Add an activity or resource>Page>Add  

  

Page Settings  

  

Page settings are optional Teachers can add them but not mandatory. In setting teachers have these 

options  

• Appearance  

• Common module settings  

• Restrict access  

• Activity completion  

• Tags  

• Competencies  
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ii. Appearance: Teachers can set how page will be displayed on screen of user using 

check box.  

  

 
  
  

  
iii. Common module settings  

In case teacher want to display the page on certain date or hide the file at the moment of uploading 

this is the step to do it.  

  

 

6. Page will start appearing on course page  

  

 

Figure 13: Course homepage>Page  

File  

When you wish to share with your students a simple file such as a Word-processed document or 

slideshow (e.g. created in MS Word, PowerPoint, or Open Office) you use the file resource type. 

It allows you to upload and display a variety of resources on your course.  

  

Adding a File  
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1. To add a resource, turn editing on mode by clicking the gear icon in the upper right of LMS 

page.  

  

 
  

Figure 1: Dashboard> My Courses> Turn editing on.  

  
  
  

2. You can add activity by clicking on Add an activity or resource present on the right side of 

page.  

  

 
  

Figure 2: Course homepage> Add an activity or resource.  

  

3. By pressing Add an activity or resource new window will appear  

4. Scroll down and select File then press "Add" button.  
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Figure 3: Add an activity or resource>File>Add  

  
  
  

5. After clicking the add button the screen will appear.  
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Figure 4: Add an activity or resource>File>Add>Adding a new file.  

6. Fill in the information  

• Name: Type in the name here you want to give to the file. File will appear with this 

name in the course.   
• Description: Description is optional it’s up to user. If Display description on the 

course page is ticked, the description will appear on the course page just below the 

name of the file.  
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• Select File: Then at the time of file selection click on file icon or drag and drop your 

file onto the arrow  

  

7. If user select file uploading icon, then a new window will pop up on screen named as File 

picker. Click on Upload file then browse file, select file from your Computer/Laptop then 

press Upload file button.  

  

  

 
  

   

Figure 5: Add an activity or resource>File>Add>Adding a new file>Select file>  

Picker  

  

  

File Setting:  

  

File settings are optional Teachers can add them or not mandatory can be proceed with default 

values. In setting teachers have these options  

• Appearance  
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• Common module settings  

• Restrict access  

• Activity completion  

• Tags  

• Competencies  

  
  

 ii.  Appearance:  

Teachers can set it display mode for students and can also set its height and width or leave as it is.  

  

 
  

Figure 6: Add an activity or resource> File>Add> Appearance  

 iii.  Common module settings  

In case teacher want to display the file on certain date or hide the file at the moment of uploading 

this is the step to do it.  

  

 
    

Figure 7: Add an activity or resource> File >Add> Common module settings  
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8. Once the settings are done press “Save and return to the course” button to save and return to 

course or “Save and display” button to save and remain on the same page.  

  

9. After the file is uploaded it appears on the course homepage  

  

 

Figure 12: Course homepage> File added.  

  
  
  

Folder:  

You can add Folder by clicking on Add an activity or resource present on the right side of page. 

The folder module enables a teacher to display a number of related files inside a single folder, 

reducing scrolling on the course page.  

A folder may be used  

  

• For a series of files on one topic, for example a set of past examination papers in pdf format 

or a collection of image files for use in student projects  

• To provide a shared uploading space for teachers on the course page (keeping the folder 

hidden so that only teachers can see it)  

 

Figure 13: Course homepage> Add an activity or resource.  

Add Folder  

  

1. In the activity chooser; select folder then click the "Add" button.  
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Figure 14: Course Homepage>Turn editing on> Add an activity or resource>Choose 

folder>Add  

  

2. This screen will be visible  

• Enter name of folder  

• Description is optional it’s up to teacher  

• Then at the time of folder creation click on folder icon  
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Figure 15: Turn editing on> Add an activity or resource>Choose folder>Add New Folder  

  

3. By clicking on Folder Icon this window will appear on screen. Enter the name of folder then 

press button Create folder.  
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Figure 16: Turn editing on> Add an activity or resource>Choose folder>Add New Folder  

>Create Folder  

4. Now the newly created folder is visible on your screen.  

  

 

Figure 17: Turn editing on> Add an activity or resource>Choose folder>Add New Folder  

  

5. After creating a folder double click on it to upload files in it. Then at the time of file selection 

click on file icon or drag and drop your file onto the arrow  

6. If user select file uploading icon, then a new window will pop up on screen named as File 

picker.  

7. Click on Upload file then browse file, select file from your Computer/Laptop then press 

Upload file button.  
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Figure 18: Turn editing on> Add an activity or resource>Choose folder>Add New 

Folder>Add new file>Picker  

Folder Setting:  

  

Folder settings are optional Teachers can add them but not mandatory. In setting teachers have 

these options  

• Appearance  

• Common module settings  

• Restrict access  

• Activity completion  

• Tags  

• Competencies  

  

  

 i.  Appearance:  

Teachers can set it display mode for students and can also set its height and width or leave as it is.  
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Figure 19: Add an activity or resource> Folder>Add> Appearance  

  
  

 ii.  Common module settings  

In case teacher want to display the folder on certain date or hide the folder at the moment of 

uploading this is the step to do it.  

  

  
  

Figure 20: Add an activity or resource> Folder>Add> Common module settings  

  

  

8. Once the settings are done press “Save and return to the course” button to save and return to  

course or “Save and display” button to save and remain on the same page.  
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Figure 25: Add an activity or resource> Folder >Add  

  
  
  

After the folder is uploaded it appears on the course homepage. Later you can add file in the folder 

uploaded.  

File added:  

  

 Once the folder is successfully added it appears in the course  

  

  

  

  

 
  

Figure 26: Course homepage>Folder added.  
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Figure 27: Course homepage>My course> Course Name> Topic>Folder  

  
  
  

Label:  

The label module enables text and multimedia to be inserted into the course page in between links 

to other resources and activities.  

Labels may be used  

  

• To split up a long list of activities with a subheading or an image  

• To display an embedded sound file or video directly on the course page  

• To Add a short description to a course section  

1.Select Label option present in Resources. After that click on button Add.  

2. To add a resource, turn editing on mode by clicking the gear icon in the upper right of LMS 

page.  
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Figure 1: Dashboard> My Courses> Turn editing on.  

  
  
  

3. You can add activity by clicking on Add an activity or resource present on the right side  of 

page.  

  

 
  

Figure 2: Course homepage> Add an activity or resource.  

  

4. By pressing Add an activity or resource new window will appear  

5.Scroll down and select Label then press "Add" button.  
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Figure 3: Course homepage> Add an activity or resource>Label>Add.  

  

6. After clicking the add button this screen will appear.  

 

Figure 4: Course homepage> Add an activity or resource>Label>Add.  

7.Fill in all the details  

• Enter label text  



52  

  

• Add settings (optional)  

• then press save and return to course  

  

  

 
  

Figure 5: Course homepage> Add an activity or resource>Label>Add>Label Text  

  
Here type your chosen words or add your resources. In the label text box words, images, links, 

media.  

  

Label Settings  

  
These settings are collapsed by default click to expand  

  

  

 
  

Figure 6: Course homepage> Add an activity or resource> Label>Add  

  

Settings  

  

• Common module settings  

• Restrict access  

• Activity completion  

• Tags  

• Competencies  
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 i.  Common module settings  

In case teacher want to display the label or hide it from user teachers can set it.  

  

 

Figure 7: Course homepage> Add an activity or resource> Label>Add> Common module 

settings  

8. Once the settings are done press “Save and return to the course” button to save and return to 

course or “Save and display” button to save and remain on the same page.  

  

9. After the label is created it appears on the course homepage.  

  

 

Figure 12: Course homepage>Label added.  

  

  

  

  

  

  

CREATING GROUPS IN COURSE   
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Groups:  

These groups can be created on each course for group activities.  

  
ADD A GROUP  

  

1. Go to LMS-> My Home Page will appear. Courses in which a teacher is enrolled will be 

shown on My Home Page. 2. Select and click upon the course you wish to import from.  

  

  

 
   

3. In the Course Detail page Click More to enter the Course Administration Panel as in the 

Figure Below  
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4. On Course Administration Panel. Click the User tab to view User related activities. Click 

Groups in order to add new Group as in the figure below  

  

  

 

5. No groups should be displayed yet so click Create group  
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6. Add the Group name and optionally a Group description.  

7. An Enrolment key enables access to the course to be restricted to only those who know 

the key. If a group enrolment key is specified, then not only will entering that key let the 

user into the course, but it will also automatically make them a member of this group.  

8. If you want you can enter an Enrolment key. A group enrolment key will let the user into 

the whole course, and it will automatically make them a member of this group.  

9. Click Save changes.  
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10. Your group should now appear on the Groups page. 11. Make sure the group is 

highlighted then click Add/remove users.  
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12. Use Search (name or email) to find the student, select and click  Add.  

13. Once you have finished adding people to the group, click back to groups.  
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Additional plugins as and when are make available from 

open sources will also be available here in this regard a 

help page will be available on LMS dashboard which 

will be continuously updated by ICT branch for latest 

information.  

  

  

  

  

  

  

  

  

  

  

  

  

GOOGLE CLASSROOM  
  

Google classroom allow teachers and students collaboration in Class. It helps teacher to 

streamline assignments, boosting collaboration, and fostering communication. A teacher can 

setup class and enroll all the student using simple and easy mechanism. The details 

demonstration is covered in next few sections of this document.  

  

Sign Up  

  
The organization with that are using G-Suit are free to use google classroom service if it is 

enabled by administrator. There for all domain users can directly Sign In to this useful feature. In 

first sign in user has to provide some one time information.  

  

First Time SIGN IN  

  

1. Go to classroom.google.com and click “Go to Classroom”  

  

https://classroom.google.com/
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2. Enter your username and click Next  

 
    

3. Enter your password and click Next.  
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4. If you're using a G Suite for Education account, click I’m A Student or I’m A Teacher.  

Note: Users with personal Google Accounts won’t see this option.  

  
  

5. Click Get Started.  
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Create Class  

In Google classroom teacher can create class by following steps below;  

  

1. On the Classes page, click Add  Create class.  

 
    

2. Enter the class name.  
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3. Fill the form properly and Click on Create.  

4. When you create a class, Classroom automatically creates a class code.  

5. You use it to invite students to the class. You can always view the class code on the 

Stream page.  

  

6. Student can join class via 2 ways  

a. Through Auto generated code  

  

b. Teacher can send invitation  

GOOGLE MEET  
Google Meet allows class participants to connect using video conference.  

  

1. The participant can join meeting by clicking highlighted link in image below.  
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2. Click in join meeting button to join as shown in image below  
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SOP RELEVENT TO LMS   
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SOP NUML’s Official Email Address  

1. NUML employee are allotted official email addresses to correspond outside NUML 

by the approval of concern department Deans/Heads.  

2. Requests for new email accounts will be sent to email emailadmin@numl.edu.pk for 

approval with detail information of users as under:-  

a. Complete Name (First Name, Middle Name, And Last Name).  

b. Department  

c. Designation with Status (Permanent, Contract or Visiting).  

d. Date of Joining in NUML. e.g. Date of Expiry of contract/service.  

3. A user will be assigned only one official e-mail address with multiple aliases on their 

name.  

4. User Email accounts are private and confidential, and strictly for use by the individual 

for whom they are created and the individuals will be held responsible for any 

improper or unethical use of their account.  

5. The password for such accounts should not be communicated to any other person in 

any circumstances.  

6. The default storage quota for email is 30 GB for individual users.  

7. All queries relating to email address be sent at : emailadmin@numl.edu.pk  

8. No query or request through private domain email address e.g., Yahoo, Hotmail, 

Gmail will be entertained.  

9. NUML e-mail should be used for official and academics purposes only. No 

objectionable material should be disseminated using NUML network or via e- mailing 

facility.  

10. Administration branch is responsible to send employee(s) name who has left NUML 

and email Admin will close/disable email address created for employee.  

11. Appointment based email ID to be used for official correspondence.  

12. The email address (as per name on appointment letter) will be used for the 

correspondence pertaining personnel assigned projects inside/outside the University.  

SOP LMS Account Registration  

1. NUML email address will be acquire by each faculty member for official corresponding in 

NUML.  

2. Teachers will be able to Register Accounts in LMS only with NUML Official Email 

Address.  

3. Teachers will be able to see courses/subjects in LMS Dashboard if their department has 

sent ICT department courses/subjects lists to upload in LMS, then ICT department will 

Bind/Enroll teachers with courses/subjects they are teaching.  

4. Students will be able to Login into their Dashboard and see courses if Department have 

sent Lists of Students to ICT Department with required data. ICT department will register 

students and will provide Usernames and Passwords of students to concerned department.  

5. Teachers will Enroll Registered Students in their respective courses/subjects.   
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ZOOM SOFTWARE   
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Zoom Software Installation  

  

This guide shows how to download and install Zoom on a computer running Windows.  

  

1. Go to the link https://zoom.us/download  

2. Click Download below the headline “Zoom Client for Meetings”  

  

  

  

 
  

   

3. Choose “Save file” to download the Zoom installation program to your computer  

a. This application will automatically download when you start your first Zoom 

Meeting.  

4. Once the download is complete, proceed with installing the Zoom application onto your 

computer by double click the exe file named ZoomInstaller.exe.  

  

  

  

https://zoom.us/download
https://zoom.us/download
https://zoom.us/download
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5. Click Run to install the application  

  

  

 
  

  

  

6. Once it installed 100%. Following Screen will be displayed  
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7. You have successfully installed the Zoom standalone Application  

HOW TO REGISTER ON ZOOM  
The User can register with ZOOM and it’s absolutely free. There are two ways to register with 

zoom that are;  

a. Registered through Website  

  

b. Register through standalone Application  

  
  

Registered through Website  

1. Go to this link https://zoom.us/signup or Click button SIGN UP, IT’S FREE on zoom 

website  

  

  

https://zoom.us/signup
https://zoom.us/signup
https://zoom.us/signup
https://zoom.us/signup
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2. On next screen you will ask for date of birth verification. Fill the information and click 

Continue Button.  

 
    

3. On next Screen you will either provide your email or you can sign up with the following 

options  

  

a. Sign in with SSO  

Single sign-on allows you to login using your company credentials  

  

b. Sign in with Google  

You can login with your personal google account  

c. Sign in with Facebook  
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You can login with your Facebook account  

  

  

  

 

4. Confirmation Email will be sent to your email. If you haven’t received the email you can 

use the option of Resend another email  
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5. If you entered an email, Zoom will send an activation email to that address. Click the 

“Activate Account” button in the email or copy and paste the activation URL into your 

browser to activate your account.  

  

 

6. On the page that opens up in your web browser, fill in your first and last name and a 

password.  
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7. On the next page, you can invite other people to create a free Zoom account via email. You 

can skip this step if you want.  
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8. Next, you’ll be given a link to your personal meeting URL and will have the option to click 

an orange “Start Meeting Now” button to start a test meeting. If you copy that URL into 

your browser or click that orange button, you should be prompted to download the Zoom 

desktop app. Follow the prompts to install the app.  
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9. Click Go to My Account to see your dashboard  
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10. You have successfully registered with Zoom.  

  

Registered through Standalone Application  

  
  

1. Run the Zoom Application and Click Sign In Button  

  

  

  

 
  

  

2. Next Screen Click Sign UP Free  
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3. Same process from Point 2 onwards.  

  

  

Zoom password change  
  
  

1. Go to link https://zoom.us/signin  

2. Login to your zoom account by using your credentials.  

  

  

  

https://zoom.us/signin
https://zoom.us/signin
https://zoom.us/signin
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3. After login you will see the dashboard. Click the Profile under Personal Tab to enter the 

profile page  

  
  

  

  

4. In order to change the password, scroll down profile page to Sign-In Password Option 

and Click Edit  
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5. Enter Old and New Password and hit Save Changes to change the password  

  
  

  

  

6. Sign out and login in again with your new password.   



81  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

   

Screencast o Matic   
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Installation  

To install the Screencast-O-Matic Recorder and Video Editor Application on a new computer 
please follow the instructions below.  

  

  

1. Go to Screencast-O-Matic.com  

  

  

  

 
  

  

2. Click on ‘Start Recording for Free’  

  

  

  

 
  

3. You’ll be taken to the Screen Recorder page. Click on ‘Launch Screen Recorder’.  

  

https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/video-editor
https://screencast-o-matic.com/video-editor
https://screencast-o-matic.com/video-editor
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/home
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
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4.A pop-up will appear indicating that the recorder is being launched. If it doesn’t appear, 

you have the option to download the recorder app.  

  

 
  

  

5.Within seconds, you’ll notice the recorder on your screen and you can start recording.  
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Recorder Controls:  

  
There are three options when recording your video. You’ll find those options on the top of your 

recorder box.  

  

1. Screen – This allows you to record anything within your recording frame.  

2. Webcam – You can record your webcam.  

3. Both – This option allows you to show your webcam AND your screen at the same time. 

This is often used when you want to point out something on your screen but still have 

your webcam up.  

Max Time – The maximum time to record is 15 minutes. With an upgrade, you can record for as 

long as you want.  

Size – You can adjust your recording frame with preset sizes (480p, 720p, Active Window or 

Full Screen) or you can adjust it by dragging the corners and sides of the frame.  

  

Narration – The app will detect audio sources connected to your computer  
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Trim, Upload and Publish:  

  
Once you are finished recording, there are several options you can use in your recording 

manager.  

  

  

 
  
  

Trim – You can trim the beginning or end of your video by dragging the bars of your video.  

  
Captions – You have the ability to add your own captions to your videos. By clicking on CC, 

you can choose to add your own captions by uploading a captions file. As part of an upgrade, 

you can use speech-to-text or type in your own using ‘blank captions.’  

  

Upload options – There are several upload and publish options you can use in the free screen 

recorder.  

  
  

1. Save as a Video File – You can save your recording as a video file. You can choose 

either an mp4, avi or flv video file. You can save your recording in a folder on your 

computer or laptop. Fill out the filename and hit Publish.  

2. Upload to Screencast-O-Matic – You can upload and get a link to share your recording.  

To do this, you’ll need to sign up for an account or connect your existing one. Please 

note: Free and Deluxe users can upload videos of up to 15 minutes into Screencast-O- 

Matic’s hosting services. Premier users have unlimited uploading times.  
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3. Share on YouTube – If you haven’t linked your account, all you need to do is click on 

‘launch web browser’ and follow the steps. Once that’s all done, fill in the information 

and it will upload directly to your YouTube account or a YouTube channel you designate.  

4. Upgrade for more uploading options. By clicking on the ‘+’ button on top of your 

menu, you can publish to other sites including Vimeo, Google Drive, and Dropbox.  

  

  

  

  

  

  

FlashBack, Screen com camera recording   
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FlashBack is a free screen recorder with advanced features. You can use this free app for anything 

from making tutorials, demos, marketing videos to video presentations or video lectures for your 

class.  

• Capture anywhere on your PC screen  

• Add webcam footage to your screen recording  

• Add audio commentary as you record  

• Easy sharing - upload to YouTube or download file  

How to Download  

1. Go to https://www.flashbackrecorder.com/  

2. On main page press the button Download Free Trial  

  

 

3. After your download is complete double click on your setup and run it  

  

  

 
Getting Started with FlashBack  

  

1. You need to set Area and other setting at start  

2. You can start your screencast by choosing to record the entire desktop screen, or a specific 
part of your screen or even an active window.  

https://www.flashbackrecorder.com/
https://www.flashbackrecorder.com/
https://www.flashbackrecorder.com/
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3. Users also have the option to use webcam while recording screen  

4. You can also choose your preferred audio devices and optionally enable your cam to be 
recorded with your screencast. Press Record button to start recording.  

  

  

  

 
  

5. So if you press selective area recording you will see this window which ask to select height 

and width of screen you want to record. Once you start recording, a countdown appears, after 

which recording begins.  



89  

  
  

  

  

6. You can pause or stop recording whenever you want. Once you press stop it will ask you to 

choose destination folder. You can choose to save your file in FBR version. the FBR file is 

your project file, which can be used for editing, saving and uploading your recorded video 

anytime.  
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7. Recording is completed you are given the option to upload the video to YouTube or Export it 

to WMV format. This player also provides options for editing and managing your recorded 

videos.  

  

  

On the Recorder main window select Options from the Tools menu  

  

• Sound: Use this tab to select when sound will be recorded, and the format and compression 

that will be used.  

• Webcam: select whether to record video from an attached webcam, and the device and 

format used.  

• Record mode: Use this tab to change your recording mode or the number of frames 

captured per second.  

• Display: Use this to set the Windows display settings during recording and how FlashBack 

windows appear during recording and in the final movie.  

• Scheduling: use these settings to have FlashBack record at a set time or when a certain 

application runs and closes.  

• Updates / Privacy: FlashBack can connect to Blueberry servers to check for updates and 

send anonymous usage statistics. You can turn these features on and off from this tab.  

• File Size: Use this tab to select options to limit the size of the movie file produced.  

• Record-time notes: You can add notes while recording by moving the mouse to one of the 

screen edges and typing. See Making notes while recording.  

• Misc: this tab contains settings relating to startup options and the various delays that 

FlashBack inserts between certain operations at the start of recording.  

• Advanced: this tab contains advanced settings relating mainly to performance  

  

  

Scheduled Recording  

Users can also schedule their recording using Set Timer option, on next window enter required 

information then press OK button.  



91  

  
  

  

  

File Editing:  

Users can edit the recorded video by adding titles, subtitles, images and highlights etc. on bottom 

of timeline there are other options like users can directly upload it on YouTube or share it etc. 

There are some editing features available for users  
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Save Recording  

After editing when video is complete it’s up to user that he wants to save/export it or upload it in 

YouTube. To save the recording press file then export after then choose MPEG4 press OK then. 

Fill the next page press export  

  

 

When the recording is exported it will ask to choose that he wants to view it or not, selects 

according to your chice.  
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OBS STUDIO   
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OBS stands for Open Broadcaster Software. OBS is easy to use, versatile free software of video 

capture for Windows, Mac OSX and Linux. You can use OBS to record desktop software, a 

webcam, or any combination of the above. OBS can be used for love streaming for example 

Facebook, YouTube etc.  

How to Download  

1. Go to https://obsproject.com/  

2. On top right corner of page press Download  

  

   

3. Select your Operating system then press button Download Installer  

   

4. After your download is complete double click on your setup and run it.  

  
  

https://obsproject.com/
https://obsproject.com/
https://obsproject.com/
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5. After installation this is how the screen will look like  

  

 

Understanding OBS  

In OBS we use two terms Scenes and Sources.  

  

• Scenes are the layout of how you want your sources to be displayed. Scenes are made up 

of multiple sources  

• Sources they are the things or elements displaying on the screen  

 
    

We have some other options in OBS that we use while using this software  

  

• Mixer this will control the audio  

• Buttons there are multiple buttons with different functionalities,  
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 Start Streaming use while going live on Facebook, YouTube or any other platform.  

 Start Recording use to record locally on your system for example you want to 

record a video using your screen and your webcam as well. It’s up to user you can 

go live with it or just record on your system.  

 Settings helps while going online or recording your video.  

  

 
  

  

Settings  

 
    

If you want to come live on social media like YouTube Facebook or any other, then press setting 

go to Stream a new window will pop up on your screen. In services dropdown will open up select 

where you want to go live.  
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Below Stream is Output option. Select it if you want to change the output option by clicking on 

output mode. You can also adjust video quality. Select Audio quality rate according to your 

choice but keep in mind higher the bit rate higher the quality. You can select the recording path 

and recording quality can also be adjusted.  

  
  

Output Screen  
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You can change the audio and video settings if you want to else go with the default one.  

  

 
How to use Webcam in OBS  

First you need to create a scene in OBS. Scenes are nothing without sources so to add sources 

click on” +” present in sources select Video capture device. Soon you click on it a new window 

appears on your screen  
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Rename your Source then select your webcam from device dropdown and press OK. Your webcam 

will start working after this process.  
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Using OBS setting enable your audio device so that your viewers can start listing to you. After 

these two steps user is ready to go live on any social media platform.  
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How to share your screen in OBS  

If you want to share PowerPoint, your browser window or desktop you can display it using OBS 

studio. You can use multiple options to display your screen and record it. Let’s start by using 

Display capture to preview what’s on your system screen, on the new window write its name 

then press OK. You will start seeing what is visible on your screen after clicking ok button. It is 

capturing what you have on your monitor.  
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Setup four Scenes in OBS  

If user want to display browser or PowerPoint or any other window of system and webcam also 

then all user need is to add different scenes and sources. As explained above first add webcam by 

adding scenes then select source and click video capture.  

To add another screen, it maybe browser or image or anything click on scenes “+” button rename 

it as you want then in sources first add webcam after saving first resource again click on “+” button 

in resource and click on Image to add the image. It will ask to select the image from your system 

then start displaying both on screen when user select second scene from scenes.  

  

  

  

 
  

  

  

Studio mode preview your scene before going to live. So you can check your screen first then make 

it live by clicking the Transition button  
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Stream to Facebook Live using OBS  

On your Facebook page click on Publishing tool then press Video Library present on left side of 

the page.  

  

  

  

 
Then press button Live. A new window will appear on your screen, copy stream key by right 

clicking on it.  
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Now go back to OBS Studio and click on setting then press stream. In services select Facebook 

Live and in stream key paste the copied stream key then select OK. Now Facebook and OBS are 

connected. In OBS press start Streaming button.  

  
  

  

  

Now move back to Facebook page to preview stream then go live. Click on Next button.  

  

 

In few second your preview is ready. Press the play button and you are ready to Go live. Add Title, 

description and tags if you want to then press Go live button.  
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After coming Live you can see video performance Now if you want to end this video press Button 

End Live Video.  
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Live on Facebook Profile/Group  

  

If you want to come live on your Facebook profile or in group using OBS. Go to your profile Click 

on Live video  

  
On left side of page you can select from dropdown that you want to come live on your timeline or 

to group etc. Then press on Use Stream Key to get key for OBS. Copy the key from Facebook 

and paste in OBS hen use same procedure as used to come live on Facebook page.  
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Stream to YouTube Live using OBS  

On your YouTube channel click on the icon present on top left of page displaying your image click 

on creator studio. Or use this link https://www.youtube.com/live_dashboard_splash  

Then press this live streaming present on left side of your screen.  

  

 
  

  

On live streaming interface scroll down and on ENCODER Setup click on reveal button copy the 

stream name/key. Then move back to OBS.  

https://www.youtube.com/live_dashboard_splash
https://www.youtube.com/live_dashboard_splash
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In OBS click on settings move to stream in Services select YouTube, then paste the stream key 

copied from YouTube channel press OK.  

  

 
  
  

Now you are connected to YouTube. To start Streaming press, the button Start Streaming then 

click on Yes.  
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Now move back to YouTube channel wait for few second it will start showing Live. Also give 

your video Title description  

  

  

  

 
  

In few minutes you will start seeing Live now again copy your stream key from YouTube move 

back to OBS paste it in settings and that’s it you are Live on YouTube  
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Creating YouTube channel   
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Create YouTube Channel  

  

1. Go to www.youtube.com and sign in with your Gmail account.  

   

2. Now when you are login to YouTube account, go the YouTube account settings and click 

“Create a channel”.  

 
3. Chose and Enter your Channel Name in text-boxes. And hit create Channel Button  

  

  

http://www.youtube.com/
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4. You will see options  

i. Customize Channel ii. 

YouTube Studio iii. 

Upload Video  

  

 
Upload your video  

  
To upload your video, click on the upload button in the middle of the dashboard and just follow 

the instructions and Press Next.  
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• Public is the default setting and means that anybody can see your video.  

• Private means only those you invite to view the video can view it (they must have 

their own YouTube accounts and the maximum number is 50 usernames).  
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• Unlisted means your video will not come up in search results or on your channel 

either. Only those who know the link can view it, and you can share the link with 

anyone, even those who do not have a YouTube account/username.  

5. To ensure the best quality for your video use the following encoding for your video. 

Upload it in MPEG4 (H.264), 1280x720 or 1920x1080 resolution.  

The file can only be 2 GB in size. To upload longer videos, verify your account using the 

following steps:  

• Go to upload page youtube.com/upload, At the bottom of the page, click  

“Increase your limit”  

• After you upload a confirmation email will be sent to your gmail account.  

 
  

  

6. While your video is uploading, you can update video setting and information about 

your video.  

7. Press “Done” after you update the video information to save your changes. 8. Once 

the upload is completed, you will be notified via your gmail account.  
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9. Then click “Publish”. You can add custom images to ensure that the front image of  

10. Your video looks nice by clicking “Custom Thumbnail”.  

Annexure  
   

Camtasia  

NUML is buying licenses for Camtasia and 5x licenses to be given to each Faculty. 

How to install and use the Camtasia Recorder and Video Editor on  

a new computer  

  

  

To install the Camtasia Recorder and Video Editor application on a new computer please follow 

the instructions below.  

  

Part 1: Installing Camtasia 

Download the Camtasia 

program.  

  

  

https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/screen-recorder
https://screencast-o-matic.com/video-editor
https://screencast-o-matic.com/video-editor
https://screencast-o-matic.com/video-editor
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Head to https://www.techsmith.com/video-editor.html and click on “Download Free Trail”.  

  
  

Run the installation program. During installation, you will need to read and accept the 

License Agreement. You will also asked to enter your license key or install the program as a 

trial. If you have your key, type it or copy it into the field and enter your name.  

https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
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Choose any installation extras. After clicking next, you will be asked to choose where Camtasia 

should be installed. Most users can keep this at the default settings. You will also be asked if you 

want to install the PowerPoint Add-in, which will allow you to insert Camtasia recordings into 

PowerPoint presentations.  

  

  

Part 2: Recording Your First Presentation  
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Open Camtasia. When you first start Camtasia, you will be taken to the Editor window.. You will 

use the Editor to start your recording and then clean it up after you are finished.  
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Click the "Record the screen" button. This is located in the upper-left corner of the Camtasia 

window. Clicking the button will automatically minimize the Camtasia Editor window and open 

the control panel for the screen recording.   
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Choose your recording area. If you are going to be switching between multiple windows, you will 

find it easiest to record your entire screen. Full Screen recording is enabled by default.  

  

You can create a custom-sized recording area by clicking the Custom button. 

A dashed line will appear around the area that will be recorded  



122  

  

  
  

   

Select your audio and video input. If you want to use your webcam, enable it by clicking the 

Webcam button. If you have multiple microphones connected to your computer, click the down 

arrow next to the "Audio" button to select the one you want to use.  

Use the Audio menu to toggle system sounds on or off. If toggled On, system alerts and beeps 

will be recorded with your presentation.  
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Test your audio input. If you are using a microphone, speak into it before recording to see 

the level appear underneath the volume slider. Adjust the volume slider until the input 

comes out around the middle of the slider.  

  

  

  

 
Open the windows you need. Before you begin recording, open all of the windows that you will 

need to access during the presentation. This will keep you from fumbling to find the window that 

you need.  
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Start recording. Press the REC button or the F9 hotkey. A countdown will appear on the screen. 

Once it disappears, everything that you do on the screen and everything you say will be 

recorded.  

  

Speak slowly and clearly, and don't rush through your steps.  

  
  

End your recording. Once you are finished with your presentation, press F10 to stop the 

recording. You can also stop it from the taskbar, but this action will be recorded and will need 

to be edited out.  

Once you finish recording, a preview of your recorded presentation will appear. Watch the preview 

to make sure everything looks OK, and then press the "Save and Edit" button.  

  

Give your project a name you will remember. Consider creating a new folder in case you end up 

splitting the project into multiple files.  

  

  

  

  

Part 3: Editing Your Presentation  
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Open the project in the Camtasia Editor. If you just finished recording and watching your 

preview, saving the project will automatically open it in the Editor. This is where you will be 

making your changes, cutting out anything unnecessary and adding transitions.  



126  

  

  
  

Choose your video dimensions. Before you can begin editing, you will be asked what 

dimensions you want the final product to be. You can choose presets from the dropdown 

menu. These presets will be labeled with what they are recommended for.  

Try to use one of the automatic dimensions. These are based off the initial recording 

dimensions, and are resized to keep the original proportions. Choosing one of these will help 

prevent the image from being squished or stretched.  

  

You can change your editing dimensions at any time by clicking the Dimensions button at the top 

of the preview pane.  
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Cut unwanted audio and video. Chances are, no matter how prepared you were, there are a 

few errors in your presentation. Luckily, you can quickly remove these errors with just a few 

clicks. Note: If your audio and video are on separate tracks on the timeline, deleting a section 

from one will not remove it from the other.  

  

Use the timeline navigation tool to find exactly where you want top cut. Click the magnifying glass 

to zoom in on the timeline, allowing for more precise control.  

  

Click and drag the red tab at the top of the Timeline navigation tool. Drag the red tab to the end 

of the section that you want to cut.  

  

Press Space to play back just the part that you have selected.  

  

Click the Cut button (scissors icon) above the Timeline to remove the selection.  
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Check that SmartFocus was applied correctly. If you scaled down your video dimensions, 

Camtasia will apply the SmartFocus effect to zoom and pan around your presentation to focus 

on the active element. It will attempt to put focus on the cursor and active window.  

  

You can see where SmartFocus was added automatically by looking for the icons in the Timeline. 

Click and drag a SmartFocus icon to move when the transition occurs.  

Click a SmartFocus icon and then click the Visual Properties button to edit exactly how the 

transition occurs. You can make the pan slower or faster, make the zoom more or less 

pronounced, or delete the SmartFocus transition entirely.  

You can remove all SmartFocus animations by right-clicking on one of the icons and selecting 

"Delete all visual animations on media".  
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Add callouts to your presentation. Callouts are visual aids that help draw the attention of the 

viewer to important aspects of your presentation. Callouts can be text or they can be symbols 

or highlights. You can also use callouts to blur out parts of the screen.  

  

Use the Timeline to navigate to the portion of your presentation that you want to add a callout 

to. Click the Callout button above the Timeline.  

Create your callout. You can use a variety of predesigned shapes, type your own text, or choose 

an animated callout.  

Click the "+Add callout" button to add it to your presentation.  

  

Move the callout around the presentation by dragging it around the preview pane. You can adjust 

the length of the callout from the Timeline.  

  

  

Part 4: Publishing and Sharing the Presentation  
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1. Click the "Produce and share" button. Once your video is edited and ready to be seen, 

it's time to export it and share it. Click the "Produce and share" button to get started.  
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2. Choose the destination. You can share directly to a few built-in services, such as 

Screencast.com and YouTube. You can also create a video file instead that you can share 

on your own or upload to another service.  

  

When creating a video file, choose the "MP4 Only" option. This will create a video that can be 

played on 

virtually 

any 

device  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

  

   

.  
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3. Log into your sharing service. If you are uploading to YouTube or Screencast, you will be 

asked for your login information so that Camtasia can connect to the service and upload the 

video for your account.   
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4. Use custom production settings. If you need to create a video in a format other than the 

provided presets, click the "Custom production settings" option when finalizing your video. 

You will be able to choose from a variety of formats, including WMV, MOV, AVI, and even 

GIF.  

  

MP4 is the most universal format for devices and web streaming.  

  

Be careful when choosing the resolution of your final product. Upscaling (increasing the 

resolution) will result in quality loss. For example, if you recorded at 800x450, avoid publishing 

at 1920x1080.[3]  

  

Strike a balance between size and quality. When setting video options, you will see a slider with 

"Smaller file" on the left and "Higher quality" on the right. Moving the slider will affect the final quality 

of the video. Keep file size in mind if you need to distribute the video to a lot of people  

https://www.wikihow.com/Use-Camtasia#_note-3
https://www.wikihow.com/Use-Camtasia#_note-3
https://www.wikihow.com/Use-Camtasia#_note-3
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.  

  

5. Decide between a bare video or packaging it with the player program. Camtasia can 

produce videos that open with the Camtasia controller bar. While you won't be able to upload 

these to a video streaming service, you can use them on your own site or distribute them 

through other methods.  

  

  

Part 5: Creating Good Presentations  

  
  

Practice as much as possible. Try to run through your presentation several times before you 

start recording. Practice any difficult words or tricky window transitions. Make sure that 

everything you'll need is going to load. Refine your script to cut out any unnecessary 

information or fluff. All of this will save you a lot of time in the Editor later down the line.  
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Move your mouse slowly and deliberately. When recording your screen, move the mouse 

steadily and slowly between each task. Try to move in straight lines without jerking the cursor 

around. Move slowly enough so that viewers will be able to see where you are moving to and 

clicking.  

  

Don't use your mouse to emphasize things on your screen! This will be extremely distracting to 

the viewer. Instead, use the Callouts feature in Camtasia to add effects that draw the viewers' 

attention to what you want to highlight.  

Don't block what you are recording with your cursor. Use your mouse to navigate and open 

what you need to, then move it out of the way so that it doesn't obstruct the viewers' view of 

what you are doing.  
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Don't rush. Slow down your presentation so that everyone can follow. Chances are, the reason 

you are doing this presentation is because you are good with the program you are 

demonstrating. Your audience, however, is unfamiliar with it, so your presentation should 

make sure that they have time to take everything in without having to pause and rewind all the 

time.  
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Record in small pieces. When creating your presentation, you may find it really beneficial to 

break it down into smaller chunks. For example, if you are making a 30 minute presentation, you 

could separate it into six 5-minute sections. This not only makes it easier for the audience (if you 

decide to keep it split, which you certainly don't have to do), it also make sit much easier to edit 

and find the exact frames you need. You can easily splice your clips together at the end  
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